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Setting Up

351Y-000
Before using the functions of the machine, the environmental conditions must be set in advance. To begin with, check

the sequences of flow required to complete the setup, and then perform the actual settings. ©Preparations Required
Before Use(P. 6)

NOTE

e The functions installed on the machine vary depending on the model you purchased. Before using the
machine, see ©Main Functions(P. 4) and check the available functions.

Configuring Initial Settings of the Machine (Setup Guide)

e You can easily configure the initial settings required to use the machine, such as date, time, and network
settings, by following the on-screen guidance. ©Setting Up Using the Setup Guide(P. 10)




Main Functions

Setting Up

351Y-001

This manual covers all the functions of the model series you purchased. Before getting started, check which functions

are available on the model you purchased.

¢ With function  — : Without function

Function MF746Cdw | MF745Cdw | MF743Cdw | MF741Cdw | MF644Cdw | MF642Cdw | MF641Cw
Copy v v v v v v v
v [ v v | = v ] =1]-
Print v v v v v v v
Scan

v

v

v

v

v

v

v

Feeder / Platen glass cover

Feeder (2-
sided
scanning)

Feeder (2-
sided
scanning)

Feeder (2-
sided
scanning)

Feeder (1-
sided
scanning)

Feeder (2-
sided
scanning)

Feeder (1-
sided
scanning)

Platen
glass cover

2-sided printing

v

v

v

v

v

v

Wireless LAN / / / / / / /
NFC '/ / / — — — —
Default System Manager ID 7654321 7654321 Not Not Not Not Not
specified specified specified specified specified
Default System Manager PIN 7654321 7654321 Not Not Not Not Not
specified specified specified specified specified

Application Library

v

v

v

v

v

v

v

Cassette Feeding Module-AF *

v

v

Copy Card Reader-F *

Barcode Printing Kit *

Send PDF Security Feature Set
*

ANER NI NN

ANEANE NN

*This is an optional item.

NOTE

e For the available driver types, see the User Software CD-ROM/DVD-ROM supplied with the machine, or see
the Canon website (https://global.canon).
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LINKS

©OViewing User's Guide(P. 687)



Setting Up

Preparations Required Before Use

351Y-002
Set up the machine following steps 1 to 5 in order. For more information about a particular step, click on the link to go

to the corresponding section. In addition, to use the machine safely, also check ©Preventing Unauthorized
Access(P. 8) .

Step 1 (OSetting Up Using the Setup Guide(P. 10)

by

v

Step 2 (OSetting Up the Network Environment(P. 15)

Configure the network settings that are not covered in the Setup Guide. If you do not need
to use the Setup Guide, configure the network settings from here.

[k
\ W 4

Step 3 QInstalling Drivers(P. 78)

°‘i;1

k4

Step 4 (OConfiguring Initial Settings for Fax Functions(P. 79)
k4

Step 5 (OConfiguring Scan Settings(P. 84)

TIPS



Setting Up

Setting from the Remote UI

e When the network environment settings are complete, you can efficiently set the machine from a computer
using Remote UI. ©Starting Remote UI(P. 427)

Importing data from another machine to save time

e Aslong as the model is the same, you can save setting data registered on another Canon printer/
multifunction machine to a computer (export) and load the setting data to this machine (import). ©
Importing/Exporting the Setting Data(P. 449)
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Preventing Unauthorized Access

351Y-003

This section describes the security measures on how to prevent unauthorized access from the external network. This is
a must-read for all users and administrators before using this machine, other printers, and multifunction machines
connected to the network. In recent years, a printer/multifunction machine connected to the network can offer you a
variety of useful functions, such as printing from a computer, operating from a computer using the remote function,
and sending scanned documents via the Internet. On the other hand, it is essential to take security measures to
reduce the security risk for information leakage, as a printer/multifunction machine has become more exposed to
threats, such as unauthorized access and theft, when it is connected to the network. This section explains necessary
settings you need to specify to prevent unauthorized access before using a printer/multifunction machine connected
to the network.

Security Measures to Prevent Unauthorized Access from the External Network
Assigning a Private IP Address(P. 8)
Using Firewall to Restrict Transmission(P. 9)
Specifying the TLS Encrypted Communication (P. 9)
Setting PIN to Manage Information Stored in the Multifunction Machine(P. 9)

Assigning a Private IP Address

An IP address is a numerical label assigned to each device participating in a computer network. A "global IP address" is
used for the communication connecting to the Internet, and a "private IP address" is used for the communication
within a local area network, such as a LAN in the company. If a global IP address is assigned, your printer/
multifunction machine is open to the public and can be accessed via the Internet. Thus, the risk of information leakage
due to unauthorized access from external network increases. On the other hand, if a private IP address is assigned,
your printer/multifunction machine is closed to a local area network and can be accessed by only users on your local
area network, such as a LAN in the company.

N

| Y | | e

L= o= Sl S
NErnet, a ermet s oenen

P L\’;‘ | Router L‘\—;

] o - L N

B !

Global IP Address Private IP Address
Can be accessed from the external network Can be accessed from the users within a local area network

CELEEEE LT

Basically, assign a private IP address to your printer/multifunction machine. Make sure to confirm the IP address,
assigned to the printer/multifunction machine you are using, is a private IP address or not. A private IP address is
found in one of the following ranges.
mRanges for Private IP addresses
From 10.0.0.0 to 10.255.255.255
From 172.16.0.0 to 172.31.255.255
From 192.168.0.0 to 192.168.255.255

For information on how to confirm the IP address, see ©Setting IPv4 Address(P. 33) .

NOTE

e If a global IP address is assigned to a printer/multifunction machine, you can create a network environment
to reduce the risk of unauthorized access by installing security software, such as a firewall that prevents
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access from the external networks. If you want to assign a global IP address to and use a printer/
multifunction machine, contact your network administrator.

Using Firewall to Restrict Transmission

A firewall is a system that prevents unauthorized access from the external networks and protects against attacks/
intrusions to a local area network. You can use a firewall on your network environment to block access from the
external network that appears to be dangerous, by restricting communication from specified IP address of the
external network. The function installed to a Canon printer/multifunction machine enables you to set up the IP
address filter. For information on how to set up an IP address filter, see ©Specifying IP Addresses for Firewall
Settings(P. 379) .

Specifying the TLS Encrypted Communication

For information on the TLS Encrypted Communication, see ©Configuring the Network Security Settings(P. 376) ,
and on the procedures to specify, see ©Configuring the Key and Certificate for TLS(P. 388) .

Setting PIN to Manage Information Stored in the Multifunction Machine

If a malicious third party attempts to gain unauthorized access to a printer/multifunction machine, setting PIN to
information stored in the machine will reduce the risk of information leakage. Canon printers/multifunction machines
enable you to protect various type of information by setting PIN.

mSetting PIN to Each Function

Setting PIN for Using Remote UI
For more information, see ©Setting a Remote UI PIN(P. 370) .

Setting PIN for the System Manager Settings
For more information, see ©Setting the System Manager ID and PIN(P. 362) .

Address Book PIN
For more information on setting a PIN, see ©Restricting Use of the Address Book(P. 413) .

Listed above are some examples of security measures for preventing unauthorized access. For more information on
the other security measures, see ©Managing the Machine(P. 359) and take necessary security measures for
preventing unauthorized access to suit your environment.
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Setting Up Using the Setup Guide

351Y-004

When the machine is turned on ( ©Turning ON the Machine(P. 116) ) for the first time, the Setup Guide starts up to
assist you to configure the initial settings of the machine by following the on-screen guidance. In the Setup Guide, the
setting screens are displayed in the following order.

Step 1 Setting the Display Language and the Country or Region

Set the language to be displayed on the operation panel screen or in reports, as well as the
country or region where the machine will be used.

1 Select alanguage.
2 Select <Yes>.

3 Select a country or region.

Step 2 Setting the Date and Time

Adjust the machine's date/time.

1 Select atime zone.

NOTE:

What is UTC?

Coordinated Universal Time (UTC) is the primary time standard by which the
world regulates clocks and time. The correct UTC time zone setting is required
for Internet communications.

2  Enter the date and time, and select <Apply>.
Tap the entry field, and enter the date and time.
Step 3 Performing the Color Adjustment

To achieve good copy quality, adjust the gradation.

1 Select <Yes>.

If you select <No>, color adjustment is not performed, and the Setup Guide
proceeds to step 4.

2 Check that the size and type of paper displayed on the screen is loaded in the
machine, and select <OK>.

3  Confirm the procedure, and select <Start>.
" An adjustment image is printed.

Open the feeder after the screen displayed during printing is closed.

5  Place the adjustment image on the platen glass.

Place the adjustment image with the print side facing down and the black
stripe toward the back side of the machine.

10
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@

6  Gently close the feeder.

7 Select <Start Scanning>.

i Adjustment starts.

When adjustment is complete, remove the adjustment image from the platen
glass.

Step 4 Configuring Automatic Cleaning of the Fixing Assembly

If the model of your machine is MF746Cdw / MF745Cdw / MF743Cdw / MF741Cdw, configure to
automatically clean the fixing assembly. If you are using MF644Cdw / MF642Cdw / MF641Cw,
the Setup Guide proceeds to step 5.

1  Check the message displayed on the screen, and select <Yes>.

If you select <No>, automatic cleaning is not set, and the Setup Guide proceeds
to step 5.

You can set automatic cleaning of the fixing assembly later. ©<Auto Clean
Fixing Assembly>(P. 494)

2 Select <On>.

If you select <Off>, automatic cleaning is not set, and the Setup Guide proceeds
to step 5.

3  Setavailable paper sources to <On>,

When cleaning is performed, paper is fed from the paper source for which you
set <On>.
NOTE:

You can use the following paper for cleaning.
- Paper sizes: Ad/Letter
- Paper types: Plain 1 to 3/Recycled 1 or 2

4 Select <Apply>.

Step 5 Setting the Wireless LAN

Configure the settings to connect to the network using the wireless LAN.

1 Select <Yes>.

If you select <No>, wireless LAN is not set, and the Setup Guide proceeds to
step 6.

Select <OK>.

Select the setting method.

11
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For more information about the wireless LAN settings, see ©Connecting to a
Wireless LAN(P. 19) .

Step 6 Configuring Settings for Toner Replenishment Service

You can configure settings for toner replenishment service. Through toner replenishment

service, new toner cartridges are automatically delivered to you before your existing toner
cartridges are used up.

NOTE:

Use of the toner replenishment service requires prior registration with select retailers. This
service is only available in certain countries.

This service can be set up through <Toner Delivery Settings> displayed on the Home screen.
Home Screen(P. 125)

1 Select <Next>.

2 Select <Accept>.

If you select <Do Not Accept>, the screen for configuring settings for toner
replenishment service is skipped and the Setup Guide proceeds to step 7.

3 Select <OK>.

If connecting to the server fails, try configuring the settings again through
<Connect to Server/Verify Connection with Server> in <Toner Delivery
Settings>. ©Home Screen(P. 125)

Step 7 Viewing Application Library

The one-touch button referred to as "Application Library" is provided in the Home screen. You
can read the description of each function.

1 To finish the Setup Guide, select <End>.

% When the Setup Guide is complete, the Home screen appears.

fe
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Setting the Date/Time

351Y-005

Set the date and time for the machine. The date and time are used as the reference for the functions specifying the
time, therefore, they need to be set accurately.

Setting the Time Zone(P. 13)
Setting the Current Date and Time(P. 13)
Setting the Daylight Saving Time(P. 14)

Setting the Time Zone

If the time zone setting is changed, the values set in <Current Date/Time Settings> are also changed accordingly.

1 Select <Menu> in the Home screen. ©Home Screen(P. 125)

2 Select <Preferences> » <Timer/Energy Settings> » <Date/Time Settings> » <Time
Zone>.

3 Select the time zone.

NOTE

What is UTC?

e Coordinated Universal Time (UTC) is the primary time standard by which the world regulates clocks and
time. Time differences exist depending on the country or area where the machine is used. The correct UTC
time zone setting is required for Internet communications.

Setting the Current Date and Time
1 Select <Menu> in the Home screen. ©Home Screen(P. 125)
2 Select <Preferences> » <Timer/Energy Settings> » <Current Date/Time Settings>.

3 Enter the date and time.

Tap the entry field, and enter the date and time.

13
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4 Select <Apply>.

Set <Time Zone> before setting the current date and time. If the <Time Zone> setting is changed later, the
current date and time are also changed accordingly.

NOTE

e The display format of the date and time can be changed, respectively.
<Date Format>(P. 466)
<Time Format>(P. 466)

Setting the Daylight Saving Time
If daylight saving time is enabled, specify the dates from which and to which daylight saving time is in effect.

1 Select <Menu> in the Home screen. ©Home Screen(P. 125)

2 Select <Preferences> » <Timer/Energy Settings> » <Date/Time Settings> » <Daylight
Saving Time Settings>.

3 Select <Off> or <On> in <Daylight Saving Time>.

When you select <On>, select <Start Date> and <End Date>, and set the month and day for each item. To set
the day, specify "what day of which week."

4 Select <Apply>.

14
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Setting Up the Network Environment

351Y-006

When connecting the machine to a wired or wireless local area network (LAN), you need to set an IP address unique to
the selected network. Select "wired" or "wireless" depending on your communication environment and networking
devices. For specific IP address settings, contact your Internet service provider or Network Administrator.

IMPORTANT

If the machine is connected to an unsecured network, your personal information might be leaked to a third
party.

NOTE

e The machine cannot connect to both wired and wireless LANs at the same time.
e The machine does not come with a LAN cable or router. Have them ready as necessary.

e For more information about your networking devices, see the instruction manuals for the devices or contact
your manufacturer.

m Before You Start

Follow these steps to connect the machine to a network.

- Check your computer settings.
{:‘, y p g

= Make sure that the computer is correctly connected to the network. For more
information, see the instruction manuals for the devices you are using, or contact the
device manufacturers.

Make sure that the network settings have been completed on the computer. If the
network has not been set up properly, you will not be able to use the machine on the
network, even if you perform the rest of the procedure below.

NOTE:

Depending on the network, you may need to change settings for the communication
method or the Ethernet type ( © Configuring Ethernet Settings(P. 53) ). For more
information, contact your Internet service provider or Network Administrator.

To check the MAC address of the machine.
(OViewing the MAC Address for Wired LAN(P. 39)
©Viewing the MAC Address and Information for Wireless LAN(P. 40)

15
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To connect to an IEEE 802.1X network, see ©Configuring IEEE 802.1X
Authentication Settings(P. 406) .

Select wired or wireless LAN.
(OSelecting Wired LAN or Wireless LAN(P. 17)

[

AR

Connect to a wired or wireless LAN.

Proceed to the section that corresponds to the setting you selected in step 2.
OConnecting to a Wired LAN(P. 18)
©Connecting to a Wireless LAN(P. 19)

B

Set the IP address as necessary.

At the time of purchase, the machine is set to automatically acquire an IP address.
Change this setting if you want to use a specific IP address. ©Setting IP

il
- Addresses(P. 32)

LINKS

OConfiguring Settings for Communication with a Computer(P. 41)
(OConfiguring the Machine for Your Network Environment(P. 52)

16
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Selecting Wired LAN or Wireless LAN

351Y-007

After you decide on wired or wireless LAN to connect the machine to the computer, select wired LAN or wireless LAN
using the operation panel. Note that if you change the setting from <Wired LAN> to <Wireless LAN> or vice versa, you
will need to uninstall the drivers installed on your computer and then reinstall them. For more information, see the
manuals for the relevant drivers on the online manual website.

1 Select <Menu> in the Home screen. ©Home Screen(P. 125)

2 Select <Preferences> » <Network>.

If the login screen appears, enter the correct ID and PIN. ©Logging in to the Machine(P. 136)

3 Select <Select Wired/Wireless LAN>.

4 Select <Wired LAN> or <Wireless LAN>.

LINKS

Setting Up the Network Environment(P. 15)
Connecting to a Wired LAN(P. 18)
Connecting to a Wireless LAN(P. 19)

17
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Connecting to a Wired LAN

351Y-008

Connect the machine to a computer via a router. Use a LAN cable to connect the machine to the router.

1 Connect a LAN cable.

Connect the machine to a router by using a LAN cable.

Push the connector in until it clicks into place.

2 Wait for several minutes.

% The IP address is set automatically.

NOTE:

You can set the IP address manually. ©Setting IP Addresses(P. 32)

LINKS

(OSetting Up the Network Environment(P. 15)

18
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Connecting to a Wireless LAN

351Y-009

Wireless routers (or access points) connect the machine to a computer via radio waves. If your wireless router is
equipped with Wi-Fi Protected Setup (WPS), configuring your network is automatic and easy. If your networking
devices do not support automatic configuration, or if you want to specify authentication and encryption settings in
detail, you need to manually set up the connection. Make sure that your computer is correctly connected to the
network.

(OSetting Up Connection Using WPS(P. 19)
(OManually Setting Up Connection(P. 20)

IMPORTANT

Risk of information leak

Use wireless LAN connection at your own discretion and at your own risk. If the machine is connected to an
unsecured network, your personal information might be leaked to a third party because radio waves used in
wireless communication can go anywhere nearby, even beyond walls.

Wireless LAN security

The wireless LAN function of this machine supports WEP, WPA-PSK, and WPA2-PSK. For the wireless security
compatibility of your wireless router, see the instruction manuals for your networking devices or contact
your manufacturer.

NOTE

Required devices for wireless LAN connection

e The machine does not come with a wireless router. Have the router ready as necessary.

Setting Up Connection Using WPS

When using WPS, two modes are available: push button mode and PIN code mode.

m Push Button Mode

Find the WPS mark shown below on the package of your wireless router. Also make sure that there is a WPS button on
your networking device. ©Setting Up Connection Using WPS Push Button Mode(P. 21)

o
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m PIN Code Mode

Some WPS routers do not support the push button mode. If WPS PIN code mode is mentioned on the package or in
the instruction manuals of your networking device, set up the connection by entering the PIN code. ©Setting Up
Connection Using WPS PIN Code Mode(P. 23)

NOTE

o If the wireless router is set to use WEP authentication, you may not be able to set up connection using WPS.

Manually Setting Up Connection

When manually setting up a wireless connection, you can either select a wireless router or manually enter the required
information. Regardless of the method, make sure that you have the required setup information, including the SSID
and network key. ©Checking the SSID and Network Key(P. 31)

m Selecting a Wireless Router

Select this setup option if you need to manually set up the connection but want to complete the setup as easily as
possible. ©Setting Up Connection by Selecting a Wireless Router(P. 25)

m Manually Entering the Setup Information

If you want to specify security settings in detail, such as authentication and encryption settings, manually enter the
SSID and network key to set up the connection. ©Setting Up Connection by Specifying Detailed Settings(P. 28)

LINKS

Setting Up the Network Environment(P. 15)
Selecting Wired LAN or Wireless LAN(P. 17)

20
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Setting Up Connection Using WPS Push Button Mode

351Y-00A

If your wireless router supports WPS push button mode, you can easily set up a connection with a WPS button.

IMPORTANT

How to operate the wireless router may vary on each device. See the instruction manuals for your
networking device for help.

1 Select <Menu> in the Home screen. ©Home Screen(P. 125)
2 Select <Preferences> - <Network>.
If the login screen appears, enter the correct ID and PIN. ©Logging in to the Machine(P. 136)

3 Select <Wireless LAN Settings>.

If the <Do you want to enable the wireless LAN?> message is displayed, select <Yes>.

4 Read the message that is displayed, and select <OK>.
5 select <WPS Push Button Mode>.
G Select <Yes>.

7 Press and hold the WPS button on the wireless router.

The button must be pressed within 2 minutes after selecting <Yes> in step 6.

Depending on the networking device, you may need to press and hold the button for 2 seconds or longer.
See the instruction manuals for your networking device for help.

NOTE:

If an error message is displayed during setup

Select <Close> and return to step 5.

21
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8 Wait until message <Connected.> is displayed.

9 Select <Close>.

n Wait several minutes until the IP address and other items are set automatically.

When more than one wireless router is available for connection, the machine connects to the device
with the strongest signal. Signal strength is measured using RSSI (Received Signal Strength Indication).

NOTE:

You can set the IP address manually. ©Setting IP Addresses(P. 32)

While the machine is connected to the wireless LAN, the Wi-Fi icon is displayed in the Home screen or
the Basic Features screen of each function. ©Basic Screens(P. 124)

NOTE

Reducing power consumption

e You can set the machine to enter <Power Save Mode> based on signals emitted from the wireless router. ©
<Power Save Mode>(P. 470)

If the IP address of the machine has changed

e In a DHCP environment, the IP address of the machine may be changed automatically. If this happens, the
connection is maintained as long as the machine and the computer belong to the same subnet.

LINKS

(OConnecting to a Wireless LAN(P. 19)
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Setting Up Connection Using WPS PIN Code Mode

351Y-00C

If your wireless router supports WPS PIN code mode, generate a PIN code with the machine and register the code to
the networking device.

IMPORTANT

How to operate the wireless router may vary on each device. See the instruction manuals for your
networking device for help.

@ From a Computer

1 Access your wireless router from a computer and display the screen for entering a
WPS PIN code.

For more information, see the instruction manuals for your networking device.

From the Operation Panel

2 Select <Menu> in the Home screen. ©Home Screen(P. 125)

3 Select <Preferences> - <Network>.

If the login screen appears, enter the correct ID and PIN. ©Logging in to the Machine(P. 136)

4 Select <Wireless LAN Settings>.

If the <Do you want to enable the wireless LAN?> message is displayed, select <Yes>.

5 Read the message that is displayed, and select <OK>.
(G Select <WPS PIN Code Mode>.

7 Select <Yes>.

% The PIN code is generated and shown on the display.

From a Computer

8 Register the generated PIN code to the wireless router.

Register the PIN code on the setup screen displayed in step 1.
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The PIN code must be registered within 10 minutes after selecting <Yes> in step 7.

NOTE:

If an error message is displayed during setup

Select <Close> and return to step 6.

From the Operation Panel

9 Wait until the message <Connected.> is displayed.

1 0 Select <Close>.

% Wait several minutes until the IP address and other items are set automatically.

When more than one wireless router is available for connection, the machine connects to the device
with the strongest signal. Signal strength is measured using RSSI (Received Signal Strength Indication).

NOTE:

You can set the IP address manually. ©Setting IP Addresses(P. 32)

While the machine is connected to the wireless LAN, the Wi-Fi icon is displayed in the Home screen or
the Basic Features screen of each function. ©Basic Screens(P. 124)

NOTE

Reducing power consumption

e You can set the machine to enter <Power Save Mode> based on signals emitted from the wireless router. ©
<Power Save Mode>(P. 470)

If the IP address of the machine has changed

e In a DHCP environment, the IP address of the machine may be changed automatically. If this happens, the
connection is maintained as long as the machine and the computer belong to the same subnet.

LINKS

(OConnecting to a Wireless LAN(P. 19)
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Setting Up Connection by Selecting a Wireless Router

351Y-00E

You can search the wireless routers (or access points) available for connection and select one from the display of the
machine. For the network key, enter a WEP key or PSK. Before selecting a wireless router, check and write down the
required setup information, including the SSID and network key ( ©Checking the SSID and Network Key(P. 31) ).

NOTE

Security settings

e If the wireless connection is set up by selecting a wireless router, the WEP authentication method is set to
<Open System> or the WPA/WPA2 encryption method is set to <Auto> (AES-CCMP or TKIP). If you want to
select <Shared Key> for WEP authentication or <AES-CCMP> for WPA/WPA2 encryption, you need to set up
the connection using <Enter Manually>. @Setting Up Connection by Specifying Detailed Settings(P. 28)

1 Select <Menu> in the Home screen. ©Home Screen(P. 125)

2 Select <Preferences> - <Network>.

If the login screen appears, enter the correct ID and PIN. ©Logging in to the Machine(P. 136)

3 Select <Wireless LAN Settings>.

If the <Do you want to enable the wireless LAN?> message is displayed, select <Yes>.

4 Read the message that is displayed, and select <OK>.
5 select <SSID Settings>.

6 Select <Select Access Point>.

% The machine starts searching for available wireless routers.

NOTE:

If a message is displayed telling that no access point can be found, check the network settings. For more
information, see "Troubleshooting (FAQ)" on the online manual website.

7 Select a wireless LAN router.

Select the router whose SSID matches the one that you have written down, and select <Next> - <OK>.
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NOTE:

To view details of security settings

Select the wireless LAN router, and select <Details>. To return to the original screen, select .

If your wireless router is not found

Check whether the machine is properly installed and ready to connect to the network. For more
information, see "Troubleshooting (FAQ)" on the online manual website.

Enter the network key that you have written down.
Enter the network key, and select <Apply>.

On how to enter text, see @Entering Text(P. 134) .

Select <Yes>.

NOTE:

If an error message is displayed during setup

Select <Close>, check whether the network key is correct, and return to step 5.

Wait until message <Connected.> is displayed.

Select <Close>.

% Wait several minutes until the IP address and other items are set automatically.

When more than one wireless router is available for connection, the machine connects to the device
with the strongest signal. Signal strength is measured using RSSI (Received Signal Strength Indication).

NOTE:

You can set the IP address manually. ©@Setting IP Addresses(P. 32)

While the machine is connected to the wireless LAN, the Wi-Fi icon is displayed in the Home screen or
the Basic Features screen of each function. ©Basic Screens(P. 124)

NOTE

Reducing power consumption

e You can set the machine to enter <Power Save Mode> based on signals emitted from the wireless router. ©
<Power Save Mode>(P. 470)
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If the IP address of the machine has changed

e In a DHCP environment, the IP address of the machine may be changed automatically. If this happens, the
connection is maintained as long as the machine and the computer belong to the same subnet.

LINKS

(OConnecting to a Wireless LAN(P. 19)
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Setting Up Connection by Specifying Detailed Settings

351Y-00F

If you want to specify the security settings in detail or cannot establish the wireless connection using the other
procedures, manually enter all the required information for the wireless LAN connection. Before specifying detailed
settings, check and write down the required information, including the SSID, network key, and wireless security
protocols. @Checking the SSID and Network Key(P. 31)

1 Select <Menu> in the Home screen. ©Home Screen(P. 125)
2 Select <Preferences>  <Network>.
If the login screen appears, enter the correct ID and PIN. ©Logging in to the Machine(P. 136)

3 Select <Wireless LAN Settings>.

If the <Do you want to enable the wireless LAN?> message is displayed, select <Yes>.

4 Read the message that is displayed, and select <OK>.
5 Select <SSID Settings> » <Enter Manually>.

6 Enter the SSID that you have written down.

Enter the SSID, and select <Apply>.

On how to enter text, see @Entering Text(P. 134) .

7 Specify the security settings based on the information that you have written down.

If you do not need to specify the security settings, select <None>.

mUsing WEP

1 Select <WEP>.

2 Select an authentication method.
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<Open System>

Sets open system authentication, which is also called "open authentication."

<Shared Key>
Uses the WEP key as a password.

NOTE:

When <Open System> is selected

When connecting to a wireless LAN, the machine experiences an authentication error if the shared key
authentication is set on the wireless router. If this happens, the machine automatically changes the
setting to <Shared Key> and retries the connection.

3 Select the WEP key you want to edit.
Select the WEP key (1 to 4), and select <Edit>.
Up to four WEP keys can be registered.

4 Enter the network key that you have written down.

Enter the network key, and select <Apply>.

5  Select the desired WEP key.
Select the WEP key you have edited, and select <Register>.

mUsing WPA-PSK or WPA2-PSK

1 Select <WPA/WPA2-PSK>.

2  Select an encryption method.

<Auto>

Sets the machine to automatically select AES-CCMP or TKIP to match the setting of the wireless router.

<AES-CCMP>
Sets AES-CCMP as the encryption method.

3 Enter the network key that you have written down.

Enter the network key, and select <Apply>.
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8 Select <Yes>.

NOTE:

If an error message is displayed during setup

Select <Close>, check whether the specified settings are correct, and return to step 5.

9 Wait until message <Connected.> is displayed.

1 O Select <Close>.

% Wait several minutes until the IP address and other items are set automatically.

When more than one wireless router is available for connection, the machine connects to the device
with the strongest signal. Signal strength is measured using RSSI (Received Signal Strength Indication).

NOTE:

You can set the IP address manually. ©Setting IP Addresses(P. 32)

While the machine is connected to the wireless LAN, the Wi-Fi icon is displayed in the Home screen or
the Basic Features screen of each function. ©Basic Screens(P. 124)

NOTE

Reducing power consumption

e You can set the machine to enter <Power Save Mode> based on signals emitted from the wireless router. ©
<Power Save Mode>(P. 470)

If the IP address of the machine has changed

e In a DHCP environment, the IP address of the machine may be changed automatically. If this happens, the
connection is maintained as long as the machine and the computer belong to the same subnet.

LINKS

(OConnecting to a Wireless LAN(P. 19)
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Checking the SSID and Network Key

351Y-00H

When manually setting up a wireless connection, you need to specify the SSID and network key of your wireless router.
The SSID and network key may be indicated on these networking devices. Check your devices and write down the

necessary information before setting up the connection. For more information, see the instruction manuals for your
networking devices or contact your manufacturer.

SSID A name given for identifying a specific wireless LAN. Some other terms used for SSID include
"access point name" and "network name."
Network Key A keyword or password used for encrypting data or authenticating a network. Some other

terms used for network key include "encryption key," "WEP key," "WPA/WPA2 passphrase,"
and "preshared key (PSK)."

Wireless Security Protocols
(Authentication/Encryption)

When manually setting up a wireless connection by specifying detailed settings, you need to
specify security settings. Check the following information:

Security types (WEP/WPA-PSK/WPA2-PSK)
Authentication method (Open System/Shared Key)
Encryption method (TKIP/AES-CCMP)

LINKS

Connecting to a Wireless LAN(P. 19)
Setting Up Connection by Selecting a Wireless Router(P. 25)
Setting Up Connection by Specifying Detailed Settings(P. 28)
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Setting IP Addresses

351Y-00)

Connecting the machine to a network requires a unique network IP address. Two versions of IP addresses are
available: IPv4 and IPv6. Configure these settings depending on the network environment. To use IPv6 addresses, you
need to properly configure the IPv4 address settings.

(OSetting IPv4 Address(P. 33)
(OSetting IPv6 Addresses(P. 36)
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Setting IPv4 Address

" X

IP:192.168.

\ W 4

(OSetting IPv4 Address(P. 33)

351Y-00K

The machine's IPv4 address can be either assigned automatically by a dynamic IP
addressing protocol, such as DHCP, or entered manually. When connecting the
machine to a wired LAN, make sure that the connectors of the LAN cable are firmly
inserted into the ports ( ©Connecting to a Wired LAN(P. 18) ). You can test the
network connection if necessary.

OTesting the Network Connection(P. 34)

Setting IPv4 Address

1 Select <Menu> in the Home screen. ©Home Screen(P. 125)

2 Select <Preferences> » <Network>.

If the login screen appears, enter the correct ID and PIN. ©Logging in to the Machine(P. 136)

3 Select <TCP/IP Settings> » <IPv4 Settings> » <IP Address Settings>.

4 Configure IP address settings.

<Auto Acquire>
Select to automatically assign an IP address via DHCP protocol. When <On> is displayed, automatic
addressing is enabled.

<Manually Acquire>

Select to configure the IP address settings by manually entering an IP address. In order to select this option,
the automatic acquirement must be set to <Off>.

<Check Settings>

Select when you want to view the current IP address settings.

mAutomatically assigning an IP address

1 Select <Auto Acquire>.

2 Select <On> in <Auto Acquire>, and select <Select Protocol>.

3 Select <DHCP>.
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NOTE:
If you do not want to use DHCP/BOOTP/RARP to assign an IP address

Select <Off>. If you select <DHCP> when these services are unavailable, the machine will waste time
and communications resources searching the network for these services.

4  Check that <Auto IP> is set to <On>.

If <Off> is selected, change the setting to <On>.

5  Select <Apply>.

NOTE:

IP addresses assigned via DHCP override the address obtained via Auto IP.

mManually entering an IP address

1  Select <Auto Acquire>, and select <Off> in <Auto Acquire> » <Apply> - <OK>,
2 Select <Manually Acquire>.

3  Enter <IP Address>, <Subnet Mask>, and <Gateway Address>, and select <Apply>.

5 Select <OK>.

6 Restart the machine. ©Restarting the Machine(P. 121)

NOTE

Checking whether the settings are correct

e Make sure that the Remote UI screen can be displayed with your computer ( ©Starting Remote
UI(P. 427) ). If a computer is not available, you can check the connection by using the operation panel ( ©
Testing the Network Connection(P. 34) ).

When you have changed the IP address after installing the printer driver

e When the MFNP port is used, the connection is maintained as long as the machine and the computer belong
to the same subnet; therefore, you do not need to add a new port. When the standard TCP/IP port is used,
you need to add a new port. ©Configuring Printer Ports(P. 45)

*If you do not know which port is used, see ©Checking the Printer Port(P. 693) .

Testing the Network Connection

1 Select <Menu> in the Home screen. ©Home Screen(P. 125)

2 Select <Preferences> » <Network>.

If the login screen appears, enter the correct ID and PIN. ©Logging in to the Machine(P. 136)
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3 Select <TCP/IP Settings> » <IPv4 Settings> » <PING Command>.

4 Enter the IPv4 address of another device on the network, and select <Apply>.

i If a proper connection has been established, <Received response from the host.> is displayed.

LINKS

Setting IPv6 Addresses(P. 36)
Viewing Network Settings(P. 39)
Configuring WINS(P. 63)
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Setting IPv6 Addresses

351Y-00L

The IPv6 addresses of the machine can be configured via the Remote UL Before
setting IPv6 addresses, check the IPv4 address settings ( ©Viewing IPv4
Settings(P. 39) ). You need to set the correct IPv4 settings to use IPv6 addresses.
Note that the scan function that uses the scanner driver or MF Scan Utility is not
available in an IPv6 environment. The machine can use the following multiple IPv6
addresses:

Type Description

Link-local address An address that is only valid within a subnet or link and cannot be used to communicate with
devices beyond a router. A link-local address is automatically set when the IPv6 function of the
machine is enabled.

Manual address An address that is entered manually. When using this address, specify the prefix length and default
router address.

Stateless address An address that is generated automatically using the MAC address of the machine and the network
prefix that is advertised by the router. Stateless addresses are discarded when the machine is
restarted (or turned ON).

Stateful address An address obtained from a DHCP server using DHCPv6.

NOTE

e For more information about the basic operations to be performed when setting the machine from the
Remote UI, see ©Setting Up Menu Options from Remote UI(P. 436) .

1 Start the Remote UI and log in to System Manager Mode. ©Starting Remote
UI(P. 427)

Click [Settings/Registration] on the Portal page. ©Remote UI Screen(P. 428)

Select [Network Settings] » [IPv6 Settings].

~ W N

Click [Edit].

5 Select the [Use IPv6] check box and configure the required settings.
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[Use IPv6]
Select the check box to enable IPv6 on the machine. When not using IPv6, clear the check box.

[Stateless Address 1]
Select the check box when using a stateless address. When not using a stateless address, clear the check box.

[Use Manual Address]
When you want to manually enter an IPv6 address, select the check box and enter the IP address, prefix
length, and default router address in the corresponding text boxes.

[IP Address]
Enter an IPv6 address. Addresses that start with "ff" (or multicast address) cannot be entered.

[Prefix Length]
Enter a number that indicates how many bits are available for the network address.

[Default Router Address]
Specify the IPv6 address of the default router as necessary. Addresses that start with "ff" (or multicast
address) cannot be entered.

[Use DHCPv6]
Select the check box when using a stateful address. When not using DHCPv6, clear the check box.

G Click [OK].

7 Restart the machine. ©Restarting the Machine(P. 121)

NOTE

Checking whether the settings are correct

e Make sure that the Remote UI screen can be displayed with your computer by using the IPv6 address of the
machine. ©Starting Remote UI(P. 427)
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Selecting settings from the operation panel
e IPv6 settings can also be accessed from <Menu> in the Home screen. (G<IPv6 Settings>(P. 474)
When you have changed the IP address after installing the printer driver

e You need to add a new port. ©Configuring Printer Ports(P. 45)

LINKS

OSetting IPv4 Address(P. 33)
(©OViewing Network Settings(P. 39)

38



Setting Up

Viewing Network Settings

351Y-00R

Viewing IPv4 Settings(P. 39)

Viewing IPv6 Settings(P. 39)

Viewing the MAC Address for Wired LAN(P. 39)

Viewing the MAC Address and Information for Wireless LAN(P. 40)

NOTE

e The IP address is not correctly configured if it is displayed as "0.0.0.0".

e Connecting the machine to a switching hub or bridge may result in a connection failure even when the IP
address is correctly configured. This problem can be solved by setting a certain interval before the machine
starts communicating. ©Setting a Wait Time for Connecting to a Network(P. 56)

e You can print a list of the current network settings. ©User Data List/System Manager Data List(P. 634)

Viewing IPv4 Settings

<Status Monitor>  <Network Information>  <IPv4> = Select the setting to view  Check the
settings

Viewing IPv6 Settings

<Status Monitor> |+ <Network Information> = <IPv6> - Select the setting to view k- Check the
settings

Viewing the MAC Address for Wired LAN

1 Select <Menu> in the Home screen. ©Home Screen(P. 125)

2 Select <Preferences> » <Network>.

If the login screen appears, enter the correct ID and PIN. ©Logging in to the Machine(P. 136)

3 Select <Ethernet Driver Settings>.

i The MAC address is displayed.
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Viewing the MAC Address and Information for Wireless LAN

1 Select <Menu> in the Home screen. ©Home Screen(P. 125)

2 Select <Preferences> - <Network>.

If the login screen appears, enter the correct ID and PIN. ©Logging in to the Machine(P. 136)

3 Select <Wireless LAN Settings>.
4 Read the message that is displayed, and select <OK>.
5 Select <Connection Information>.

G Select the setting to view.

NOTE:

Viewing security information

To view WEP and WPA/WPA2-PSK information, select <Security Settings>.

Viewing from the <Status Monitor> screen
<Wireless LAN Status> and <Latest Error Information> can be viewed from <Status Monitor>.

<Status Monitor> - <Network Information> » <Network Connection Type> & Select the setting to view

LINKS

Connecting to a Wireless LAN(P. 19)
Setting IPv4 Address(P. 33)

Setting IPv6 Addresses(P. 36)
Configuring DNS(P. 57)
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Configuring Settings for Communication with a
Computer

351Y-00S
Specify the protocol and port when operating the machine from a computer via the network. Before configuring the

machine for printing or faxing from a computer, perform the basic setup procedures. For more information, see the
manuals for the relevant drivers on the online manual website.

LPD

o

WsD

OConfiguring Printing Protocols and WSD Functions(P. 42)
(OConfiguring Printer Ports(P. 45)
OSetting Up Print Server(P. 49)

NOTE

e Protocols explained here are rules for delivering document data between a computer and the machine, and
can be selected according to intended purposes or the network environment.

e Ports are gateways for passing data between network devices. If a communication failure occurs in the
network connection, the port settings may be the cause of the problem.
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Configuring Printing Protocols and WSD Functions

351Y-00U

Configure the protocols that are used for printing documents from a networked computer.

NOTE

e For more information about the basic operations to be performed when setting the machine from the
Remote UI, see ©Setting Up Menu Options from Remote UI(P. 436) .

1 Start the Remote UI and log in to System Manager Mode. ©Starting Remote
UI(P. 427)

2 Click [Settings/Registration] on the Portal page. ©Remote UI Screen(P. 428)
3 Click [Network Settings].

4 Configure printing protocols.

mConfiguring LPD or RAW

1 Select [LPD Settings] or [RAW Settings] » [Edit].

2 Configure the settings as necessary.
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[Use LPD Printing]
Select the check box to print via LPD. When not using LPD printing, clear the check box.

[Use RAW Printing]
Select the check box to print via RAW. When not using RAW printing, clear the check box.

[RX Timeout]
Set a value as the restart wait time for data reception. If data reception does not resume within the set
time, printing is canceled.

3 Click [OK].
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m Configuring WSD

1  Select [WSD Settings] » [Edit].
2 Configure the settings as necessary.
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[Use WSD Printing]
Select the check box to print via WSD. When not using WSD printing, clear the check box.

[Use WSD Browsing]
Select the check box to obtain information about the machine from a computer via WSD. This check box is
automatically selected when the [Use WSD Printing] check box is selected.

[Use WSD Scanning]
WSD scanning enables you to scan documents to a computer without installing the scanner driver. Select
the check box to scan documents via WSD. When not using WSD scanning, clear the check box.

[Use Computer Scanning]

Select the check box to use WSD scanning by operating the machine with the operation panel. This check
box can only be selected when the [Use WSD Scanning] check box is selected. To perform scanning, select
<Scan> in the Home screen and specify a WSD-connected computer as a scan destination ( ©Scanning
and Saving to a Computer(P. 291) ).

[Use Multicast Discovery]

Select the check box to set the machine to reply to multicast discovery messages. If the check box is
cleared, the machine stays in sleep mode even when multicast discovery messages are flowing on the
network.

3 Click [OK].

5 Restart the machine. ©Restarting the Machine(P. 121)

NOTE

Selecting settings from the operation panel

e LPD, RAW, and WSD settings can also be accessed from <Menu> in the Home screen.
<LPD Settings>(P. 476)
<RAW Settings>(P. 476)
<WSD Settings>(P. 477)

Setting up WSD network devices

e The WSD network devices can be added from the printer folder. Open the printer folder ( ©Displaying the
Printer Folder(P. 688) ) » click [Add a device] or [Add a printer] and follow the on-screen instructions. For
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more information about how to install the driver for the WSD network, see the manuals for the relevant
drivers on the online manual website.

To change the port number

e The same port number used for the machine and a computer must be used for printing protocol.
Configuring Printer Ports(P. 45)
Changing Port Numbers(P. 385)

LINKS

Configuring Printer Ports(P. 45)
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Configuring Printer Ports

351Y-00W

Printing errors can occur when the IP address of the machine has been changed, or when a printer has been added via
the Windows printer folder. These errors are typically caused by incorrect printer port settings. For example, an
incorrect port number or port type may have been specified. In such situations, your attempt to print fails because the

document data cannot reach the machine. To fix this type of problem, configure the printer port settings on the
computer.

IMPORTANT

To perform the following procedure, log in to your computer with an administrator account.

1 Open the printer folder. ©Displaying the Printer Folder(P. 688)

2 Right-click the driver icon for this machine, and click [Printer properties] or
[Properties].

3 Click the [Ports] tab and configure the required settings.
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mAdding a port

If you have changed the IP address of the machine or you have selected an incorrect port while installing
drivers from the Windows printer folder, add a new port. There are two types of port: "MFNP Port" and
"Standard TCP/IP Port." Select the port type according to your environment.

MFNP Port This is a port that allows the IP address of the machine to be detected automatically.

) Even if the IP address of the machine is changed, the connection is maintained,
(only for IPv4 environment)
provided that the machine and the computer are in the same subnet. You do not need
to add a new port every time the IP address is changed. If you are using the machine
in an IPv4 environment, you should normally select this type of port.

You can add an MFNP port only when you installed the driver from the provided
CD-ROM/DVD-ROM, or when you downloaded and installed the printer driver or
the fax driver from the Canon website.
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Standard TCP/IP Port This is a standard Windows port. When you use this type of port, you need to add a
new port every time that the IP address of the machine is changed. Select this type of

port when you are using the machine in an IPv6 environment and when you cannot
add an MFNP port.

Adding an MFNP port

Click [Add Port].
2 Select [Canon MFNP Port] in [Available port types] and click [New Port].

3 Select [Auto Detect] and select the machine when it is detected, and then click [Next].
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If the machine is not detected

Click [Refresh]. If the problem persists, select [IP address] or [MAC address], enter the IP address or
MAC address of the machine ( ©Viewing Network Settings(P. 39) ) and then click [Next].

Click [Add] » [Finish].

Click [Close].

Adding a standard TCP/IP port

Click [Add Port].

Select [Standard TCP/IP Port] in [Available port types] and click [New Port].

Click [Next].

Enter the IP address or the DNS name of the machine, and click [Next].

The [Port Name] is entered automatically. If necessary, you can change it.
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When the next screen is displayed, follow the instructions on the screen.
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*When you select the [Device Type], select [Canon Network Printing Device with P9100] under [Standard].

Click [Finish].

Click [Close].

mChanging the port type or number

1
2
3

1
2

If the printing protocol (LPD or RAW) has been changed on the machine side ( © Configuring Printing
Protocols and WSD Functions(P. 42) ) or the port number has been changed ( ©Changing Port
Numbers(P. 385) ), the corresponding settings on the computer must also be configured. This operation is
not needed for WSD ports.

MFNP port

Click [Configure Port].

Under [Protocol Type], select [RAW] or [LPR], and change the [Port Number].

Click [OK].

Standard TCP/IP port

Click [Configure Port].

Under [Protocol], select [Raw] or [LPR].
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If you selected [Raw], change the [Port Number].

If you selected [LPR], enter "Ip" in [Queue Name].

3 Click [OK].

4 Click [Close].

LINKS

Setting Up Print Server(P. 49)
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Setting Up Print Server

351Y-00X

With a print server, you can reduce the load on the computer that you print from. The print server also makes it
possible to install the drivers on each computer over the network, which saves you the trouble of installing the drivers
on each computer by using the provided CD-ROM/DVD-ROM. To set up a computer on the network as a print server,
configure the settings for sharing the printer.

IMPORTANT

To perform the following procedure, log in to your computer with an administrator account.

You may be unable to install drivers over the network depending on the operating system and the bit
architecture (32-bit or 64-bit) of the print server and client computers.

When implementing a print server in a domain environment, consult your Network Administrator.

NOTE

To carry out Department ID Management when using a print server

e "Canon Driver Information Assist Service" must be added during the printe